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Color printing workflow in DTP environment v2.0 

On completion of this module you will have an understanding of the DTP 
workflows of color images derived from cameras and scanners; and the application 
of profiles for color management. 

There are pointers to more detailed information contained in other color modules. 

 

The specific areas covered are: 

Color-spaces and color-space conversion 

Digital cameras 

Scanners 

DTP output 

Color management 

Proofing 
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Module training overview 

Target audience will be: 

Any technician who completed "Basic Color 2" module in Professional level, or is studying to become 
a color specialist. This module helps to develop an understanding of color printing workflow 
processes in a desktop publishing environment. 

 

Attainment Targets: 

• To gain an introductory knowledge of workflow in DTP for color printing, principally in the 
office environment, but not focused on high-level commercial offset printing 

• To gain an introductory understanding of color-spaces, and the conversion of RGB to CMYK 
spaces 

• To gain an introductory understanding of workflow in processing images that are acquired 
from digital cameras 

• To gain an introductory understanding of workflow in processing images acquired from 
scanners 

• To gain an introductory knowledge of workflow for desktop publishing 

• To gain an introductory knowledge of image control in Photoshop, Illustrator and InDesign 

• To gain an introductory knowledge of proofing 
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1 Workflow 

There are two distinct output paths for desktop publishing: 

• Office printing using digital copiers (for example: documents, brochures and 
newsletters that are produced within an office); 

• Commercial offset printing. 

If accurate color reproduction is required, decide on the printing method before 
commencement. This is because output systems and printing presses have different color 
management requirements. 

A typical workflow is shown in the following diagram (see next page). 
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Two distinct output paths for desktop publishing: office printing and commercial offset printing. Files 
that are sent to a digital copier can be in PDF-X format, or in a number of other formats. 
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2 Color-spaces 

2.1 Primary color-spaces 

Human eyes perceive color with receptors for the additive primary colors: red, green and blue 
(RGB). All other colors are a mixture of the three, in what is called the additive color process. If 
we add 100 percent of all three primary colors, we get white. If we add different percentages 
of the colors, we get different hues. Computer monitors use the additive process with the 
three primary colors (RGB). 

Color on paper works differently: we use pigments in inks and toners that absorb some colors 
of the surrounding light, and reflect others. The primary pigments are cyan, magenta, and 
yellow. They are called subtractive colors because, as you print pigments onto a white page, 
they absorb (subtract) some of the light. If we add 100 percent of all three subtractive colors, 
we get black. The black lacks density, so we also add black ink on the printing press, and call it 
four-color process printing (CMYK). 

 

Additive colors RGB appear on computer monitors. Subtractive colors CMY appear printed on paper. 

These two systems are known as the RGB and CMYK color-spaces. 
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2.2 Device and editing color-spaces 

In workflow we talk of device color-space and editing color-space. 

2.2.1 Device color-space 

Each piece of equipment that is involved with images is referred to as a device: cameras, 
scanners, computer monitors, proofers, platesetters, and printing presses are all devices. 

No device can reproduce the whole of the visible color spectrum. The range of colors that an 
individual device can reproduce is called that device’s color-space, or its gamut. The color-
space for a particular device is defined digitally, and is called a device profile. Each device 
profile has categories: input, output, and display profiles. 
 

 

 
A CIE chromaticity diagram showing a generic interpretation of the colors visible to the human eye (the 
human vision gamut). The computer monitor can display a wider and richer gamut than can the 
printer. Inside the brown line is the gamut that is displayed by a typical computer monitor. Inside the 
yellow line is the gamut of a generic offset printing press. 
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2.3 Editing color-space 

Editing color-space (or working color-space) is a gamut within which editing of images can be 
performed in a controlled and consistent way. The color-space of a particular device is specific 
to only that device. The color-space of the editing-space is independent of devices. They are 
said to be gray-balanced: colors with equal amounts of red, green, and blue appear neutral 
gray. Editing-spaces are perceptually uniform; that is, changes to lightness, hue, or saturation 
are applied equally to all the colors in the image. The most common editing color-spaces are: 
Adobe RGB 1998, and sRGB. 

Adobe RGB 1998 color-space is the most widely used color-space for printing, because it has 
a wide gamut. 

sRGB color-space reflects the characteristics of lower-quality computer monitors and is not 
suitable for printing because of its restricted color gamut. 

 

2.4 Offset printing color-spaces 

Most countries have printing standards for quality control in color offset printing. They 
include: 

• 3DAP for Australia (though SWOP is also used) 

• SWOP for USA 

• Eurostandard Color for Europe 

• Japan Color for Japan 

These standards specify many parameters for papers, inks, and technical issues beyond the 
scope of this module. 

3DAP 

3DAP (Digital Data Delivery for Australian Publications) is an industry group committee 
formed to ensure that advertising material prepared by different sources for use in publication 
printing can be faithfully reproduced together on the same press sheet. It is also important for 
the same material inserted in multiple publications to be consistent.
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3 RGB to CMYK conversion 

3.1 Need for conversion 

Images for a desktop publishing job may come from various sources, various programs, and in 
various formats. The primary input color-space may be either RGB or CMYK. 
 
 

 

 
If your output is to be CMYK, then plan which images need conversion and when to make the 
conversion. Input and output profiles are connected through the color management system. 

Digital copiers always print CMYK, so RGB images must be converted to CMYK, otherwise color 
distortions will happen. It is important that CMYK images should never be converted twice (or 
colors will be distorted), so you have to plan your work. 

 

3.1.1 CMYK-to-CMYK conversion 

It is possible to convert CMYK-to-CMYK, but the process is not recommended because it rarely 
gives good results, especially in the reproduction of blacks. The most affected are pure blacks 
that have no other colors (for example, black text). They will be converted to a black color that 
also contains other inks besides true black. 

If you decide to convert CMYK-to-CMYK, one method is to use a type of ICC profile that is 
known as a device link. The process can be performed with software like ProfileMaker 
Professional, or MonacoPROFILER. 

See also the module DTP Applications, section 1.1.2 Color Management using ICC Profiles. 

 



Color printing workflow in DTP environment v2.0 

12 

3.1.2 Conversion options 

The questions are: 

• what images need conversion; and 

• where will the conversions take place? 

The three options are shown in the following diagram. 
 

 

 
Many DTP documents include both CMYK and RGB images, therefore the combination of above 
workflow will be used. 
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3.2 Batch conversion 

If you have a lot of RGB images which need conversion to CMYK, they can be batch converted  
in Adobe Photoshop. The method is accessed by choosing: File > Automate > Batch. 

 

4 Digital cameras 

4.1 Digital camera workflow 

The workflow depends on: 

• whether you can control the taking of the images (by specifying color-space and 
image format); or 

• whether the images are supplied to you before you can specify. 

There are many types of image file formats. Adobe Photoshop will open most common files, 
but only a few are suitable for your output. You are most likely to receive files that are RAW, 
TIFF, or JPEG. You will usually output in either TIFF or JPEG, depending on quality. See the 
table in section 4.3 Digital camera file formats. 
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The workflow for camera images depends on how much control you have on the source. 
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4.2 Digital camera color-space 

To ensure that color is accurately reproduced, the editing color-space must be set. For the 
purposes of this module, we are concerned with the color gamut (the range of colors that will 
be used). The most common color-spaces used, is either Adobe RGB (1998), or sRGB. 

Adobe RGB (1998) is the color-space that you should use because it has a wider color gamut. 
sRGB is too narrow for desktop publishing. Although the sRGB color-space can be converted 
to Adobe RGB (1998), the conversion does not achieve better results.  The original color data 
cannot be created after the photograph has been taken. Also, such a conversion can lead to 
uneven tonal gradation (also known as skipping, stepping, or tone jump). 

 

 

 
Different color-spaces: sRGB has a noticeably narrower gamut. 
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4.3 Digital camera file formats 

There are numerous image file formats that you could receive. The most common are: 

 

Short 
name 

Extension Color 
quality 

File 
size 

Compression Used for 

RAW .raw highest high nil Maximum color detail with high 
bit-depth 

TIFF .tif high high nil Widely used for printing 

JPEG .jpg medium small lossy Widely used for printing where 
smaller file size is more important 
than quality 

EPS .eps high medium nil Used in PostScript printing 
environment. 

Does not allow soft proofing. 

Not recommended profiles 

GIF .gif low small  Low resolution on web sites 

PICT .pct low small  Low resolution previews 

 

Adobe Photoshop will open and process all these files, but only a few are suitable for your 
output. You are most likely to receive files that are RAW, TIFF, or JPEG. You will usually output 
in either TIFF or JPEG, depending on quality. You may use EPS in a page layout program (such 
as Adobe InDesign). This is suitable for files which are prepared for offset printing in a 
PostScript environment. Remember that EPS images don’t allow soft proofing (see section 8.5 
Soft (monitor) proofs). 
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4.3.1 File resolution 

You must be sure that the file resolution is adequate for the job in hand. Be aware that higher 
resolution files produce a larger file size. The total job size can add up substantially with many 
files in a document. It would be nice to print everything at the highest resolution possible, 
however consider the time and cost increase with higher resolution. The resolution should be 
high enough to achieve the required final quality that is wanted. 

There are various measures of resolution that are often confused – be careful! 

DPI (dots per inch) is used for printers (more dots gives higher resolution). 
 

Printer Typical dpi 

Office laser printers 600 

Inkjet printers Up to 6,000 

Offset CTF image setter 1,200 to 4,800 

 

PPI (pixels per inch) is used for computer monitors, scanned images, and raster outputs from 
software like Adobe Photoshop (more pixels gives higher resolution). 
 

Printer ppi 

Website pictures 72 to 96 

Halftones for offset printing 300 or 350 

It is common to use a PPI value twice the value of LPI. 

 

LPI (lines per inch) is used for screen frequency (more lines gives higher resolution). 
 

Publication type Screen frequency lpi 

Newspapers and newsletters 90 to 100 

Brochures and magazines 133 to 175 

Fine art books and magazines 150-200 
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4.4 Checking digital camera profiles 

It is a simple matter to check or convert a profile. In this example, the image is intended for 
output for offset printing, so the appropriate profile is determined as the Destination Space. 
Sometimes there is a noticeable shift in the display colors as the new profile gives alternate 
information when describing the color numbers. 

 

 

 
To check camera profiles, look at Convert to Profile, which is found in the Edit menu. 
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4.5 Digital camera color-space conversion 

4.5.1 Color-space conversion 

Whether RGB to CMYK conversion is necessary, is discussed in section 3 RGB to CMYK 
conversion. 

The conversion may be done at the desktop publishing stage, or by the RIP in the color MFP. If 
RGB images are converted to CMYK at the desktop stage, the preferred method in Photoshop 
is simple: in the Edit menu, select Convert to Profile, then choose an appropriate profile in the 
Destination Space pop-up menu (see following illustration). 

 

Conversion of color-space is found in the Convert to Profile dialog box. 
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4.5.2 Soft proof of CMYK 

When in Photoshop, you can view a simulated CMYK on your monitor without changing the 
file (see the following illustration). Your monitor must be profiled for this process. 

 

Soft proof of CMYK is in the View menu. 

 

4.6 Checking received camera data 

Before outputting image files, you need to check: 

• File format (see section 4.3 Digital camera file formats). 

• Color-space (see section 4.4 Checking digital camera profiles).  

• Batch conversion for color-space is discussed in section 3.2 Batch conversion.  
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4.7 Printing a digital camera sample 

Check that the settings you have used appear correct, by printing sample images. 

As mentioned in section 3 RGB to CMYK conversion, conversion of RGB images to CMYK can 
take place in two places: 

• at the desktop publishing stage; or 

• by the RIP built into the software of the color MFP (called in-RIP separation). 

Whichever method you choose, CMYK images must not be converted twice. This means color 
management is activated in one place, and it is deactivated in the other. 

The example following will show the C7000 printer options for color conversion in Adobe 
Photoshop CS5.
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The steps to control conversion at the time of printing – color management is controlled either by the 
software or the printer. 
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5 Scanners 

5.1 Scanning workflow 

The workflow depends on: 

• whether you can control the image scanning (by specifying color-space and image 
format); or 

• whether the images are supplied to you before you can specify. 

There are many types of image file formats. Adobe Photoshop will open most common files, 
but only a few are suitable for your output. You are most likely to receive files that are TIFF, or 
JPEG. You will usually output in either TIFF or JPEG, depending on quality. (See section 5.7 
Scanner file formats). 
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5.2 Originals 

There are three common types of original that may be scanned: 

• Transparency This is reversal (also called positive) film, which is exposed in a non-
digital camera. When you look through the film, the colors look right. The size is 35 
mm (called a slide); though 6 cm x 6 cm (120 or 220 film), and 12.7 x 10.2 (5 x 4 inches) 
are used for higher quality. Transparencies have been the first choice for quality for 
decades, though professional photographers are now increasingly using digital 
cameras. 

• Negative color This is negative film, which is commonly used for amateur snapshots. 
The film has an orange mask which makes the assessment of the image hard until 
converted to positive. Negatives are difficult to profile for accurate scanning, and 
generally should be avoided. 

• Reflective art This is a positive image on an opaque substrate (paper) – usually a 
photograph or drawing. 

If you intend to scan an image from a printed book or magazine, the scanner has to be set 
specifically to avoid moiré patterns (an unwanted effect caused by interfering dot patterns). 

It is also possible to scan objects by placing them directly on the glass of a flatbed scanner. 

 

5.3 Scanner types 

The two basic types of scanner are shown in the table. 
 

Scanner 
type 

Originals Ease of 
use 

Cost Quality attainable 

Drum Positive or negative 
transparencies (film) 

Skilled High Superlative 

Flatbed Positive or negative 
transparencies (film) 

Reflective art (on paper) 

Easier Medium 
to low 

Wide variety of results depending on 
mode and operator’s skill 

 



Color printing workflow in DTP environment v2.0 

26 

 

 
The operation of these two types of scanners is very different. Drum scanners transmit light through 
transparent originals. The flatbed scanner shown here is in reflective-art mode. Some flatbed scanners 
can also scan transparencies. 

 

5.4 Scanner profiles: Outline 

For accurate and consistent results, scanners need to be profiled. Your monitor and printer 
should also be profiled. You should have: 

• A target original This is a piece of film or paper which is controlled carefully in 
manufacture, displaying color patches and images. Typical standards for these are 
IT8.7/1 for transparency, and IT8.7/2 for reflective targets; 

• Profiling software Bought with the target original; 

• A target description file (TDF) This has the measurements of the color patches on the 
target. 

Building input profiles for both drum scanners and flatbed scanners is essentially the same. 
You should check documentation available for your particular scanner. 



Color printing workflow in DTP environment v2.0 

27 

 

A typical scanner target (Kodak Q-60E3 IT8 color calibration target). Note the color patches, an image 
and patches showing skin tones, and a grayscale step-wedge. 

 

5.5 Scanner profiles: Building 

5.5.1 Scan the profile target 

• Open the scanner’s software application and turn off all the automatic features such as 
black point, white point, remove color cast, and sharpening. 

• If available, set the scanner gamma to your workplace standard value. (The concepts of 
gamma are discussed in the module “Light sources and monitors in color DTP”. 
Typically gamma is set in Photoshop at: Edit>Color Settings.) 

• Scan the target, and save it as a high-bit TIFF file (choose the file format first if the 
software demands it). Don’t save any embedded profile. 

 

5.5.2 Prepare the target scan 

Before building the profile, you need to crop the image and ensure that its long edge is 
exactly parallel to the top of the computer monitor. Some profiling software can achieve this; 
if not, then prepare the scan in Photoshop. 

• Open the scanned profile in Photoshop – don’t embed any profile. 

• If necessary, rotate the image so its long edge is exactly parallel to the top of the 
Photoshop frame (Image > Rotate > Arbitrary). 

• If necessary, crop the image (Image > Crop). 
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• If your profiling software does not allow high-bit TIFFs, downsize the file to eight bits 
per channel (Image > Mode > 8-Bits/Channel). 

• Check the color patches for dust specs, and spot any defects with the Photoshop clone 
tool. 

 

5.5.3 Build the scanner profile 

Open the prepared target scan in your profiling software, and follow the software’s directions. 

 

Building a scanner profile with ProfileMaker. On-screen directions are easy to follow. 
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5.6 OS-level color management 

There are two systems that can help in color management: one for Apple and one for 
Windows operating systems. Neither is a full color management system, but can be adequate 
if not seeking exemplary results. 

There is a full discussion of this topic in the module Color printing workflow in an office 
environment. 

 

5.6.1 ColorSync 

ColorSync is an Apple application that provides an easy way to ensure accurate color in your 
images from the time you capture them until you print or display them. It does not work on 
Windows systems. 

Devices, such as scanners, displays, digital cameras, and printers, each handle color 
differently. Color matching between devices can be difficult and time-consuming. ColorSync 
does this automatically, by translating the color spaces of your devices so they match as 
accurately as possible. The color information for each device is saved as a ColorSync profile, or 
an ICC profile. 

Most Mac OS X graphic applications save ColorSync profiles directly in your document. 
ColorSync compares these profiles with the profile for your display when you view the 
document and with your printer profile when you print it. 

 

5.6.2 WCS (Windows Color System) 

WCS is a Windows 7 system similar to ColorSync. Microsoft has implemented the Windows 
Color System (WCS) which add support for more color spaces (beyond RGB to CMYK, to 
device-independent color spaces such as CIELAB), as well as support for additional colors for 
processes such as HiFi Color. There are two main types of color profiles that Windows 
continues to support: Windows Color System (WCS) and International Color Consortium (ICC) 
color profiles. 

It does not work on Apple Macintosh systems. See the module Color Printing Workflow in an 
Office Environment, section 2 OS for more information.
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5.7 Scanner file formats 

5.7.1 Selection process 

There are two methods of acquiring an image from a scanner, and these methods determine 
the process of selecting the output file format. 

• In the scanner software If you acquire images directly using the scanner software, the 
software will offer you a Save function that sets the file format – this may be before or 
after the scan. 

• TWAIN acquisition Image processing programs (like Photoshop), provide a function 
that drives the scanner and imports the image directly into the image processing 
program. In Photoshop, the process is: File > Import > TWAIN Acquire. The file format 
is selected when you save the file. 

 

5.7.2 Formats for scanner files 

The most common file formats used in scanning are as follows. 
 

Short 
name 

Extension Color 
quality 

File 
size 

Compression Used for 

TIFF .tif high high nil Highest quality. Widely used 
for printing.  

JPEG .jpg medium small lossy Widely used for printing where 
smaller file size is more 
important than quality 

EPS .eps high medium nil Used in PostScript printing 
environment. 

Does not allow soft proofing. 

Not recommended profiles 

PDF .pdf  small some Not for photographic images. 
Mostly used for optical 
character recognition, or 
document circulation. 

PICT .pct low small  Low resolution previews 

DCS .eps  large nil An outdated format that 
involves 5 CMYK color 
separations. 
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5.7.3 Which format to use for scanners 

This choice is mostly influenced by the desired quality. Size is only a factor if large files have to 
be transmitted on the Internet. 

For best quality, use TIFF. For smaller file size, but at a loss of quality, use JPEG. 

When outputting to a PostScript environment where vector images are also included, then the 
EPS format is recommended - but remember that EPS images don’t allow soft proofing. 

 

5.7.4 File resolution for scanners 

Ensure that the file resolution is adequate for the job in hand. See section 4.3.1 File 
resolution described in the camera section of this module. 

 

5.8 Color-spaces for scanners 

Most scanners output in the RGB color-space, however some can output directly in CMYK – 
especially drum scanners. You can retouch images in either the RGB or CMYK color-spaces. It is 
best to do retouching in RGB because of the wider gamut. If you routinely retouch in RGB, 
there is no advantage of scanning in CMYK. However, if you have your scanner profiled and no 
retouching is required, then direct output in CMYK can save time. 

 



Color printing workflow in DTP environment v2.0 

32 

5.9 Embedding a profile 

Embedding a profile is simply the saving of a profile in a document file. This will define the 
source profile used when converting to any other color-space. 

To embed a color profile in a document in Photoshop, Illustrator, or InDesign: 

• Save or Export the document in a format that supports ICC profiles.  

• Save or Export the document in one of the following file formats: Adobe PDF, PSD 
(Photoshop), Ai (Illustrator), INDD (InDesign), JPEG, or TIFF.  

• Select the option for embedding ICC profiles. 
 

 

 
Embedding a profile in Photoshop. 
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5.10 Checking scanner data 

Before outputting image files, it is important that you check the following: 

• File format (see section 5.7 Scanner file formats). 

• Color-space (see section 5.8 Color-spaces for scanners). 

 

6 DTP output 

6.1 DTP workflow 
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6.2 Settings for DTP outputs 

Settings for DTP outputs are covered in detail in other color modules. The references are listed 
below Color settings 
 

Application Module name Section number 

Photoshop Color Management in Adobe Creative Suite 2.6 

Illustrator Color Management in Adobe Creative Suite 3.5 

InDesign Color Management in Adobe Creative Suite 4.5 

 

6.3 Profile settings 
 

Application Module name Section number 

Photoshop Color Management in Adobe Creative Suite 2.2 

Illustrator Color Management in Adobe Creative Suite 3.2 

InDesign Color Management in Adobe Creative Suite 4.3 

 

6.4 Profile conversion in Photoshop 
 

Application Module name Section number 

Photoshop Color Management in Adobe Creative Suite 2.5.2 
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6.5 Profile warning dialogues 

When you import or place an image into an application you might receive a warning dialogue 
to advise mismatching profiles. There are three options: 

• Use the embedded profile as the source profile; 

• Use the embedded profile as the source profile, then convert from that source profile 
to another profile; or 

• Ignore the embedded profile and assume or assign a different profile. 

Some applications offer these alternatives, others offer only one or two. Before you change a 
profile, it may be good to contact the source of the image. A typical warning dialogue follows. 

 

 

Other information is included in the following modules. 
 

Application Module name Section number 

Photoshop Color Management in Adobe Creative Suite 2.1 

Illustrator Color Management in Adobe Creative Suite 3.1 

InDesign Color Management in Adobe Creative Suite 4.1 
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7 Color management 

Settings for DTP outputs are covered in detail in other Konica Minolta modules. The references 
are listed below. 

 

7.1 Color management with RIP 

If you are printing with a RIP, be sure to deactivate color handling in the DTP software, see 
section 4.7 Printing a digital camera sample. 

 

7.2 Color management with application 
 

Application Module name Section number 

Photoshop DTP Applications 1.1.4 

Illustrator DTP Applications 1.2.2 

InDesign DTP Applications 1.3.2 
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8 Proofing 

8.1 Purpose of proofs 

The purpose of proofing is to check the various elements of a printing job. Proofing includes 
checking that: 

• all type and illustrations are present, and in the correct place; 

• colors are applied in the correct places and that colors are accurately reproduced; 

• spelling and other checks of grammar are also made. 

The machine used to produce a proof is called a proofer. 

 

8.2 Three types of proofs 

There are two types of proof: a Layout proof, a Validation print and a Contract proof. The 
contract proof needs to be very accurate. Sometimes initial layout proofs may be produced on 
a less-capable proofer, with the contract proof being produced on a better machine. 

• Layout proofs are used to check that copy and images are correct, and that colors are 
accurately applied in the correct places. Spelling and other checks are also made at 
this time. The machine used for these proofs is called a layout proofer. 
 
More than one layout proof may be required before the final OK is given for offset 
printing to start. 

• Validation print  which is the color reference proof at the design stage, and reflects a 
high quality validation of the proposed job content. It refers to ISO 12647-8. Konica 
Minolta bizhub PRO C6501 has been certified as a 'Validation printing system' (Details: 
http://fogracert.fogra.org). The Validation printer may also be referred to as a layout 
proofer. 
 
More than one Validation print may be required before the final OK is given for offset 
printing to start. 

• Contract proofs are the final proofs. They form the basis of the printing contract, and 
the model from which the printer visually monitors work as it comes off the offset 
press. 

 

http://fogracert.fogra.org/�
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8.3 Cautions in proofing 

All printing machines use some form of ink (or toner). The range of colors that can be 
reproduced by printing machines, inks, and by different types of stock (paper), is called the 
gamut (see the illustration in 2.2.1 Device color-space). The gamut of all ink systems is always 
smaller than the range of colors visible in nature. 

The gamut of toner is generally smaller than the inks used on an offset press. For this reason, 
caution must be exercised in assessing colors which are displayed on proofs, especially where 
high color-fidelity is required in offset printed work. 

 

8.4 Konica Minolta color MFPs 

8.4.1 Calibration and profiling 

Settings for calibration, profiles and color management for Konica Minolta color MFPs are 
covered in other Konica Minolta modules. The references are listed below. 
 

Operation Module name Section number 

Calibration EFI ColorWise 3.2 

Creating profiles EFI ColorWise 4.1 

 

8.4.2 Color management 

Some applications allow options for color management to be switched ON or OFF. It is 
important to have color management turned ON only in one place, while it is turned OFF in 
the other (see the table below). 
 

 Color management 

in application 

Color management in RIP 

Color management 
controlled by application 

On Off 

Color management 
controlled by RIP 

Off On 

   

For further information see • Color Management in Adobe 
Creative Suite. 

• Example dialogue box next page. 

Section 4.7 Printing a digital camera 
sample in this module 
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Switching color management on and off in InDesign. 
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8.5 Soft (monitor) proofs 

A soft proof (also called a monitor proof) is the simulation of how a document will look when 
it is printed. Soft proofing converts the colors in the document, and then displays them on the 
monitor so that they simulate the final printed output. The files are not actually changed, it is 
only the rendering of the colors on the monitor that change. 

The process has limitations because it is unlikely that the monitor gamut will be the same as 
that of the printer. Also, the process does not work with EPS or DCS file formats. 

Soft proofing is covered in other Konica Minolta modules. The references are listed below. 
 

Application Module name Section number 

Photoshop Color Management in Adobe Creative Suite 2.7 

Illustrator Color Management in Adobe Creative Suite 3.6 

InDesign Color Management in Adobe Creative Suite 4.6 

 

 

8.6 Remote proofs 

Increasingly there is the demand for people to be able to proof files in more than one office, 
often in different countries. Files can be transferred from one location to another without 
trouble, but we must be sure that the print at the receiving end is the same as the print in the 
hands of the sender. This is where remote proofing fits in. 

The process involves proprietary software that works on a PDF file: 

• a print is made on a standard paper; 

• color patches on the print are measured with a spectrophotometer; 

• a second file is produced which includes the original PDF, spectrophotometer 
readings, paper profiles, and other data that allow the received file to be reproduced 
accurately; 

• the received file is processed essentially in reverse order to the above. 
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8.6.1 Remote proofing in various countries 

Remote proofing is being used in Europe and in the U.S.A. 

 

Country Source of information 

Europe www.remoteproof.org 

USA www.sonydadc.com 

www.absolute-proof.com/the_halftone_dot_simulation_issue.htm 

www.americanprinter.com/mag/printing_coming_soon_screen 

 

8.6.2 Remote proof requirements 

To operate a remote proofing system both sender and receiver must use the same system. 
You require: 

• proprietary software; 

• standard paper stock; 

• a spectrophotometer. 
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